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Introduzione 5

1 Introduzione

L'apparato realizza un coder stereo completamente digitale completo di coder RDS (opzionale) e
limitatore di preenfasi.

11 Revisioni

1.1.0 17/06/2014 prima edizione

2.0.0 23/09/2014 aggiornamento funzionalita firmware 2.0

2.0.1 20/11/2014 aggiornamento funzionalita firmware 2.1

3.0.0 10/03/2015 aggiornamento funzionalita firmware 3.0

3.1.0 18/12/2015 aggiunte funzionalita solo versione coder MPX
3.1.0 25/01/2016 aggiornamento funzionalita firmware 3.1

3.2.0 14/09/2016 aggiornamento funzionalita firmware 3.2

1.2 Avvertenze

Prima di compiere qualunque operazione, attenersi alle norme di sicurezza contenute nel
seguente paragrafo.

Il costruttore declina ogni responsabilita in caso di danni a persone o cose dovuti alla non
osservanza, anche parziale, delle seguenti indicazioni

¢ Accertarsi che la tensione di alimentazione corrisponda a quanto riportato sull’apparato.

¢ Verificare che I'impianto elettrico sia dotato di presa di terra.

e Utilizzare solamente prese di corrente dotate di collegamento a terra

¢ Disconnettere I'alimentazione prima di compiere qualsiasi operazione all'interno dell’apparato.

e |l dispositivo di sezionamento dell’apparato € il cawo di alimentazione, pertanto questo deve essere
facilmente accessibile e la presa deve essere posta in prossimita dell'apparato stesso.

¢ Qualungue operazione che comporti I'accesso alle parti interne dell’apparato deve essere
compiuta, dopo la disconnessione di questo dalla rete elettrica, esclusivamente da personale
tecnico qualificato.

© 2025 ITEL Elettronica e Telecominicazioni Snc
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1.3

1.4

Pannello frontale

Indicatori presenti sul pannello frontale

« RDS: Il coder RDS ¢ attivo, se lampeggiante € in funzione "AudioMuteRDS"
vedi paragrafo Pl, PTY e AudioMuteRDS.

e CLIP: il livello del segnale applicato allingresso analogico & eccessivo.

* DIG IN: lingresso digitale AES/EBU é selezionato come fonte audio

* NET: l'ingresso streaming & attivo (opzionale).

La navigazione dei menu e modifica dei parametri awiene mediante la manopola.

Pannello posteriore

o lEeA | o o o
B> eee

(=]
VA DIGIN LEFTIN RIGHTIN 19K OUT/

° o

SCAIN RS232 USBDRIVE _LAN

Connettori e regolazioni su pannello posteriore

¢ DIG IN (XLR F) ingresso AES/EBU

e LEFTIN (XLR F) ingresso audio analogico sinistro

¢ RIGHT IN (XLR F) ingresso audio analogico destro

e 19K OUT/MPXIN (BNC F) uscita riferimento 19KHz per coder RDS esterno (1Vpp onda

trapezoidale) o ingresso MPX per scambio audio (opzionale)

e MPXOUT (BNC F) uscita composita MPX (+6/-6dBm)

e SCA IN (BNCF) ingresso miscelatore per segnale SCA / RDS esterno (-20dB)
e CTRL (DSUB 9/25M) connettore controllo GPI (opzionale)

e RS232 (DSUB 9F) connettore controllo RS232

e USB DRIVE (USB-A) connettore disco USB per backup audio (opzionale)

e LAN (RJ45) connettore LAN
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Introduzione 7

1.5

Navigazione ed editing

La navigazione nei menu e modifica dei parametri awiene mediante la manopola posta sul pannello
frontale. Nel menu principale che appare al termine del caricamento del firmware, € possibile
selezionare i sottomenu relativi alle varie impostazioni.

DMPX Coderx
Audio Input

ID: STATION NAME

Premendo la manopola si pud entrare nel sottomenu selezionato.

Una wolta entrati nel sottomenu desiderato, se sono presenti parametri modificabili, si potra
procedere all'editing.

HH Set Input :Digital
Analog lev: @ dB
Dig. lev: ©@.8 dB
Net lev: @.8 dB

Premendo la manopola, apparira un “*” accanto al primo elemento modificabile. L'indicatore non
appare se sulla finestra non sono presenti elementi modificabili

HESet Input:Digital =*
Analog lev: @ dB
Dig. lev: ©B.80 dB
Net lev: B.@ dB

Ruotando la manopola si pud posizionare il cursore *' sugli altri elementi editabili presenti nella
finestra corrente.

HES=t Input :Digital
Analog lev: © % dB
Dig. lev: ©8.8 dB

Net lev: B.8 dB

Volendo ora modificare il livello di uscita del segnale RDS, si prema nuovamente la manopola. Un
simbolo “<” apparira accanto al parametro per indicare che questo € in fase di editing.

© 2025 ITEL Elettronica e Telecominicazioni Snc



DMPX Digital stereo coder

HES=t Input :Digital
Analog lev: B < dB
Dig. lev: ©.8 dB

Net lev: B.8 dB

Ruotando la manopola si potra ora modificare il parametro selezionato.

HES=t Input :Digital
Analog lev: -6 { dB
Dig. lev: ©.28 dB
Net lev: B.@ dB

Una wlta impostato il valore desiderato, si prema nuovamente la manopola. Il simbolo tornera “*" ad
indicare che si é tornati in modalita di navigazione. Si potranno quindi andare a modificare altri
parametri all'interno della stessa finestra.

HE =t Input :Digital
Analog lev: -6 ¥ dB
Dig. lev: B.@ dB
Net lev: ©0.@8 dB

Se invece le operazioni di editing sono terminate, si prema ancora una wlta la manopola. Il simbolo
“*" scomparira e sara possibile, ruotando la manopola, navigare nelle altre finestre

HESet Input :Digital
Analog lev: -6 dB
Dig. lev: B.8@ dB
Net lev: ©.8 dB

All'interno di qualsiasi sottomenu, una pressione prolungata della manopola causera il ritorno al
menu principale

DMPX Coderx
Audio Input

ID: STATION NAME
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2.1

211

Funzionalita display

Di seguito vengono riportati i menu disponibili nella versione software attuale.

Coder RDS

DMPx Coderx
RDS Generator

ID: STATION NAME

In questa sezione sono comprese tutte le impostazioni del coder Rds.
Livelli e flags RDS

RDS: ON LEV:3.8 KHz
Edit DS:® Active DS:0

TP: OFF TA:OFF RT:OFF
MS:MUS COMPR: ON AH:OFF

RDS(ON/OFF): attiva / disattiva il coder RDS

LEV: impostazione livello di iniezione sottoportante RDS
Edit DS: selezione del DATA SET per la modifica [
Active DS: selezione del DATA SET in onda @

TP (ON/OFF): impostazione stato flag TP

TA (ON/OFF): impostazione stato flag TA

RT (ON/OFF): attivazione invio radiotext (blocco 2A)

MS (MUS/SPC): impostazione flag MUSIC/SPEECH
COMPR (ON/OFF): attivazione flag "COMPRESSED"
AH (ON/OFF): attivazione flag "ARTIFICIAL HEAD"

Il flag "mono/stereo" verra impostato automaticamente a seconda del tipo di modulazione MPX
selezionato.

[1INella versione Multizone sono presenti due Set di configurazioni RDS: DATA SETO e DATA SET1
(DSO0 e DS1). | data set possono essere richiamati mediante comando su protocollo di
comunicazione o mediante il programma RD-Link. Il cambio di data set mediante RD-Link awviene
gquando questo riceve il comando SPLIT ON / SPLIT OFF nella tag "CommandText" del file .xml
(attualmente disponibile solo in alcuni sistemi di automazione); alla ricezione del comando,
l'apparato INVERTIRA' il dataset in onda (se € attivo il DSO mettera in onda il DS1 e viceversa).
Selezionando il DATA SET da editare con "Edit DS: " si possono inserire tutti i dati nei menu
successivi, se la voce "Edit DS:" & su O tutti i dati nei menu (flags, PSN, RT, AF list) riguardano il
set 0, se "Edit DS:1" i dati riferiscono al set 1.

[2lActive DS imposta e/o visualizza il data set attualmente in onda.

© 2025 ITEL Elettronica e Telecominicazioni Snc



Funzionalita display 11

212 PI,PTY e AudioMuteRDS

PI:5330
PTY: 9 Varied

AudioMut eRDS: ON

SAVE

Pl: Impostazione del codice Pl associato all’emittente

PTY: Program Type, tabella di descrizione del tipo di programmazione effettuato dall’emittente.
AudioMuteRDS: Se attiva, questa funzione spegne la codifica RDS in mancanza di audio in
ingresso, per evitare che in aree senite da altri impianti la ricerca dei ricevitori vada a sintonizzarsi
sulla frequenza muta. Il tempo di intervento & impostabile nella pagina FALLBACK, AlImTime. Lo
spegnimento della codifica RDS viene segnalata con il lampeggio del led verde posto sul frontale del
dispositivo.

Le modifiche diverranno effettive una volta salvate.

2.1.3 Monitor PS e Radiotext

PS MON iMY RADIO |
RT MON My Radio My best

radio in town

PS MON: Program Station Name attualmente in onda

RT MON: Indicazione del radiotext attualmente in onda.

Qualora sia attivo il radiotext plus per la stringa radiotext attualmente in onda, verra aggiunto il
simbolo "+" all'etichetta "RT"

Le funzioni Radiotext Plus, PSN dinamico e CT (clock time) sono disponibili utilizzando il software
RD-Link.

2.14 Impostazione PS

PS 1 :MY RADIO

Dur(secs): 2 SAVE DEL

In questa finestra e possibile inserire e modificare le stringhe PS che verranno \isualizzate nel
ricevitore, ognuna delle quali pud essere lunga fino a 8 caratteri.

PS 1..24: selezione della stringa da editare.

Dur(secs): tempo di permanenza, in secondi, della stringa attualmente selezionata. Impostando
una durata pari a zero, verra disabilitata la visualizzazione della stringa corrispondente.

SAVE: salva la stringa modificata

DEL: cancellazione della stringa selezionata

© 2025 ITEL Elettronica e Telecominicazioni Snc
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2.15

2.1.6

Le modifiche dovranno eventualmente essere salvate prima di selezionare una nuova stringa da
editare o prima di uscire dalla finestra, altrimenti verranno perse.

Radiotext

RT 2<:My Radio My best
radio in town

Dur{mins): 1 SAVE DEL

In questa finestra e possibile inserire e modificare le stringhe RT, ognuna delle quali pud essere
lunga fino a 64 caratteri.

RT 1..24: selezione della stringa da editare.

Dur(mins): tempo di permanenza, in minuti, della stringa attualmente selezionata. Impostando una
durata pari a zero, verra disabilitata la visualizzazione della stringa corrispondente.

SAVE: salva la stringa modificata

DEL: cancellazione della stringa selezionata

Le modifiche dovranno eventualmente essere salvate prima di selezionare una nuova stringa da
editare o prima di uscire dalla finestra, altrimenti verranno perse.

Liste AF

AfList: 1 Fregs:14
Freqg #: 1 181.©

Freqg INSERT DELETE
List SAVE CLEAR

Finestra di editing delle frequenze alternative. E' possibile inserire 25 frequenze sulla prima lista per
il metodo "A" o 24 liste per il metodo "B". Per ulteriori dettagli sulle modalita A e B, si faccia
riferimento alla sezione Finestra AF List riguardante il software di programmazione.

AfList 1...24: selezione della lista AF da editare.

Fregs: indicazione del numero di frequenze presenti nella lista.

Freq #: selezione del numero di frequenza in lista, da 1 a 25, e modifica della frequenza
selezionata.

Freq INSERT: inserimento di una frequenza nella posizione "Freq #" selezionata. Le frequenze
preesistenti in lista verranno spostate di conseguenza.

Freq DELETE: cancellazione della frequenza "Freq #" selezionata

List SAVE: salva le modifiche

List CLEAR: cancella tutte le frequenze presenti in lista

Note: La lista, una volta modificata, verra utilizzata solo dopo che sia stata salvata mediante il tasto
SAVE. Se verra selezionata una diversa lista (AfList) o si uscira dalla finestra di editing prima che
sia stata salvata la lista, verranno perse tutte le modifiche. Eventuali frequenze vuote (--.-) presenti
in lista, verranno eliminate automaticamente nel salvataggio.

© 2025 ITEL Elettronica e Telecominicazioni Snc



Funzionalita display 13

2.2

221

222

Regolazioni ingresso audio

DMPx Coderx
Audio Input

ID: STATION NAME

In questa sezione sono presenti le impostazioni relative agli ingressi audio e alla commutazione
automatica di emergenza.

Regolazione e visualizzazione livelli audio

Input:DIG Gain: ©.80 dB

-24  -1a -1z - A £ 1z

Le barre superiori indicano il livello audio in ingresso: il livello va regolato affinché il livello di picco sia
pari a 0dB.

La barra inferiore indica il livello di clipping del segnale entrante. Picchi istantanei fino a +3dB sono
possibili specialmente quando il segnale, eventualmente gia limitato da un processore audio posto a
monte, ha subito un processo di codifica / decodifica MPEG.

E' possibile variare la soglia di clipping mediante il menu Limiter e Clipper.

E' possibile selezionare e regolare il livello di qualsiasi canale, ma non verra cambiato il canale
correntemente in onda.
Per cambiare il canale di ingresso, & necessario utilizzare la finestra successiva.

Selezione canale di ingresso

Audio input:  Analog, ingresso analogico
Digital, ingresso AES/EBU
Net ingresso da modulo streaming.

Analog lev: livello attenuatore ingresso audio, imposta il livello di ingresso al conwertitore A/D. I
livello nominale € indicato nelle barre:

Set Input :Digital
Analog lev: 9.8 dB

Dig. lev: 0.0 dB
Net lev: .80 dB

La regolazione iniziale dell’'apparato andrebbe fatta in modo che il massimo livello di ingresso
analogico sia uguale o solo leggermente superiore a tale limite.
In nessun caso dovra illuminarsi l'indicatore CLIP posto sul pannello frontale.

Dig. lev: regolazione livello di ingresso digitale AES/EBU

© 2025 ITEL Elettronica e Telecominicazioni Snc
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2.2.3

Net lev: regolazione livello ingresso modulo streaming.

La regolazione dei singoli canali & fatta a passi di 0,1dB

Impostazioni fallback (audio backup)

L'apparato pud venir impostato per commutare in onda automaticamente un ingresso ausiliario nel
caso in cui il livello audio dell'ingresso principale risulti inferiore ad una soglia minima.

Fal lback:0FF OnAir:DIG
x [1:ANA AlmTime : 30

o [12:DIG BackTime: 120
o I3:NET AlmThr: -680 dB

Fallback (ON/OFF): attiva / Disattiva lo scambio automatico sul canale di riserva

OnAir: indicazione canale audio attualmente in onda

I1 - 12 - I3: Elenco canali. | canali sono elencati in ordine di priorita, con la massima priorita
assegnata al canale 1.

Qualora un canale a priorita piu alta venga a mancare, verranno attivati i canali a priorita inferiore e
questi rimarranno attivi fino

a quando non torni disponibile un canale a priorita maggiore.

AlmTime: timeout di entrata in allarme

BackTime: timeout di ritorno una wlta cessata la condizione di allarme sul canale principale.
AlmThr: soglia di allarme audio

Se il livello di entrambi i canali L/R della fonte principale sono superiori alla soglia di allarme, questa
verra mantenuta in onda. Quando invece anche un singolo canale risulti inferiore alla soglia,
trascorso il timeout di allarme, verra messa in onda la fonte di backup. Al ripristino della condizione
di corretto funzionamento del canale principale, trascorso il tempo "Back Timeout", questo verra
posto nuovamente in onda.

Nota: le impostazioni verranno applicate una volta usciti dal menu.

© 2025 ITEL Elettronica e Telecominicazioni Snc
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2.3 Regolazioni uscita audio

DMPx Coderx
Audio Output

ID: STATION NAME

In questa sezione sono presenti le impostazioni relative alle uscite audio DIG OUT - L R OUT (solo
se le uscite opzionali sono presenti).

2.3.1 Regolazione livelli di uscita

ANA Out lev 0.0 dBu
DIG Out lev -6.0 dBFS

QUT deemph SEUS
Qut pos: clip&Filt

ANA Out lev: livello di uscita audio analogica nei connettori posteriori XLR Left-Right OUT
DIG Out lev: livello di uscita audio digitale nel connettore posteriore XLR DIG OUT
Out deemph: deenfasi applicata all’'uscita (relativo alla sola uscita audio non per l'uscita MPX).
Out pos: punto di acquisizione del segnale audio, pud essere scelto fra:
Post clip&flt: il segnale di uscita & prelevato al termine della catena clipper e filtro 15KHz.
Pre filter: il segnale & prelevato prima del filtro 15KHz e dopo il clipper.
Pre clipper: il segnale & prelevato prima del clipper..

2.4 Regolazioni uscita MPX

DMPx Coderx
MPXx Output

ID: STATION NAME

241 Modulazione MPX e impostazione livelllo pilota

Modulation : Stereo
Preemphasis: Sbus
: 5.0 KHz

Pilot Level
Pilot Phase: 8.00 Deg

Modulation (Stereo, Mono L+R, Mono L, Mono R):

Stereo: modulazione stereo

Mono L+R: modulazione mono ottenuta sommando i canali sinistro e destro.

Mono L, Mono R:modulazione mono ottenuta da un singolo canale.
Preemphasis: preenfasi 50/75uS, La preenfasi va impostata secondo le norme tecniche locali.
Pilot level: livello di iniezione del tono pilota a 19KHz.

© 2025 ITEL Elettronica e Telecominicazioni Snc
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242

24.3

Pilot Phase: regolazione fase del tono pilota.

Impostazioni livello uscita

Audio level : 89 b4
Composite lev: 0.8 dBu

Test Tone (1Y):0FF

Audio level: percentuale livello audio nel segnale composito.

In un segnale monofonico, privo di sottoportanti pilota e RDS, tale livello pud essere lasciato al 100%
e cio produrra una deviazione di 75KHz. In tutti gli altri casi andrebbe ridotto in base ai livelli di
iniezione delle due sottoportanti, pena la sowamodulazione. Ad esempio, se si desiderasse un livello
RDS di 2KHz e un livello del tono pilota di 6KHz, il livello audio non potra essere maggiore di :

100*(1- ((DewPilot+DevRDS)/75))
che, nel caso sopra descritto, corrispondera a:
100*(1- ((6+2)/75))=89.3%

Composite level: livello di uscita MPX

Test tone (!): se attivato, viene messo in onda un tono di 400Hz, avente livello pari al 100% della
modulazione.

Se le sottoportanti e la percentuale audio sono state regolati correttamente, la modulazione non
superera tale livello.

Impostazioni Limiter e Clipper uscita

Preemph Limiter: OFF
Qutput CLiplLev : 9.1 dB

Preemph Limiter: attiva un limitatore di preenfasi nel caso in cui il segnale in ingresso al
codificatore non sia stato precedentemente limitato in dinamica da un processore audio, oppure se
quest'ultimo non & stato espressamente progettato per impiego broadcast FM.

Clip level: regolazione livello di clipping rispetto a 0dB.
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2.5 Impostazioni sistema

DMPx Coderx
System

ID: STATION NAME

2.5.1 Display, Presets Dipendenti, ID stazione

Contrast: 16

ID: STATION NAME

Contrast: regolazione contrasto del display.

ID: identificativo apparato. E' un'etichetta di 16 caratteri a disposizione dell'utente per identificare
I'apparato.

25.2 GPleopzione Split

76543216
GPI status : QDA

Split ctrl port:O0FF
Invert split status:0FF

Mediante questo menu € possibile selezionare remotamente il canale da mettere in onda o gestire
uno splittaggio pubblicitario in uscita MPX (opzionale).
La selezione é possibile tramite scheda GPI, seriale e Network.

GPI status: indica lo stato delle 8 porte disponibili, da 7 a 0.

Split ctrl port: abilita la funzione e seleziona la modalita di comunicazione
OFF: funzione non attiva

GPI: funzione attiva, accetta comandi su porta posteriore CTRL

SER: funzione attiva, accetta comandi su porta seriale RS-232

NET: funzione attiva, accetta comandi da rete LAN.

Invert split status: inverte lo stato di commutazione dellingresso MPX
OFF: con nessun comando applicato si € in modalita [SPLITTING]
ON: con nessun comando applicato si & in modalita [NETWORK]

Lo stato di splittaggio viene visualizzato nella parte superiore del display.

In modalita [SPLITTING] in uscita MPX & presente il segnale processato proveniente da Ingressi
Analogico o Digitale o Net Ip stream (se presente).

In modalita [NETWORK] in usicta MPX & presente il segnale applicato a MPX IN.
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Connettore posteriore GPI (CTRL)

GPI port status:

: Pin 6 - Mette in onda il canale ANALOGICO
: Pin 2 - Mette in onda il canale DIGITALE
Pin 7 - Mette in onda il canale NET/IP

Pin 3 - Mette in onda il canale MPX (SPLIT)
Pin 8 - Non usato

Pin 4 - Non usato

Pin 9 - Non usato

: Pin 5 - Non usato

NoahRhRwNhMROQ

DB9M

Not Used e
Not Used - (@& 4 (9 Not Used

Not Used
Set MPX Input (SPLIT)- 83 © orrse

Set NET/IP Input
Set DIGITAL Input -8 2 g Set ANALOG Input
GND

Gli ingressi si attivano mettendo a massa il relativo pin o fornendo una tensione da 5 a 12VDC, in
questo caso andranno spostati i jumpers posti sulla scheda all'interno dell'apparato, da posizione
“CLOSE” a “ VIN".

La selezione dei canali tramite porta GPl awiene con priorita esclusiva su un solo canale, se
vengono attivati pitl ingressi contemporaneamente \viene ripristinato il canale prima della selezione,
soltanto il canale MPX ha priorita assoluta e ad ogni sua attivazione non tiene conto dello stato degli
altri 3 ingressi portando il segnale MPXIN in MPX OUT.

Esempio 1: € in onda il canale Analogico, viene attivato il pin 2 mettendo in onda il canale Digitale,
nello stesso momento si attiva anche il pin 7 NET/IP, non essendo valida la selezione di due canali
in contemporanea ritorna in onda il canale Analogico.

Esempio 2: € in onda il canale Digitale, viene attivato il pin 6 mettendo in onda il canale Analogico,
nello stesso momento si attiva il pin 3 MPX, resta attivo il canale analogico ma l'uscita MPX &
commutata verso MPX IN.

Comandi Network da rete Lan:
Selezionando NET su "Split ctrl port" possono essere inviati comandi via rete lan utilizzando il
protocollo UDP con scheda ethernet standard, il protocollo TCP con scheda opzione IP Streaming.

[AB010103] selezione ingresso analogico

[AB010200] selezione ingresso digitale

[AB010301] selezione ingresso NET/IP

[AB010406] o [AA010100] selezione ingresso MPX

[AB010002] o [AA010001] ritorno al canale principale

Il comando di selezione va inviato completo di parentesi quadre e ripetuto continuamente altrimenti
dopo 10 secondi l'apparato rientra sul canale principale.
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2.5.3 Impostazione password

User Password: 0 % 5)%]
Autologout (mins): 3

LOGOUT

User Password: in questa sezione si puo inserire una password numerica che verra richiesta
all'awio del dispositivo. Impostando "0000" (valore di default) verra disabilitata la richiesta di
password.

Autologout (mins): temporizzazione di blocco automatico. Se non viene compiuta alcuna
operazione da pannello frontale nelliintervallo specificato, I'apparato si blocchera e sara necessario
reinserire la password per accedere nuovamente.

LOGOUT: blocca immediatamente l'apparato, senza che venga attesa la temporizzazione.

SAVE: salva le modifiche eventualmente apportate alla password o alla durata della temporizzazione
di logout automatico.

25.4 Impostazione Ethernet

IP : 192 168
GWY : g @ 0 0

Port : 548000
NetMask: 24

IP: indirizzo ip del dispositivo

GWY: indirizzo ip gateway

Port: indirizzo della porta di comunicazione
NetMask: maschera di rete in notazione CIDR.
APPLY: applica le modifiche.

Questa pagina ¢ visibile solo se é stato installato il modulo di comunicazione ethernet.

255 Info Sistema

Sys: revisione firmware operativo

Proc: revisione firmware processore audio e coder MPX
Hw: revisione hardware

BL: revisione bootloader

SN: numero di serie identificativo dell'apparato.
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2.5.6

2.5.7

Opzioni

PURCHASED OPTIONS
%% G155 515 55 % %1% 5 510 5 % 0 G

ENTER

Finestra di inserimento del codice di acquisto delle opzioni disponibili.

Inserire il codice per l'opzione desiderata fornito dal costruttore, quindi spostarsi sul controllo ENTER
e premere l'encoder frontale.
L'apparato verifichera il codice inserito e, se questo risulta corretto, attivera I'opzione richiesta.

Esempio per il coder RDS:

OPT IONS
%% %1% % %1% %% % %1% 5 %1% %15 % G
[RDS]

ENTER

Sicurezza

Per proteggere il dispositivo da manomissioni, & possibile abilitare una password di sicurezza
accedendo al menu System, Impostazione password.

All'awio del dispositivo (o trascorso il tempo di autologout) verra quindi mostrata la pagina di login
dowe é richiesto linserimento della password.

Passcode
Ite\h LOGIN

LOGIN: effettua l'accesso ai menu.

Perdita della password: Se la password venisse dimenticata, oltre il 20° tentativo errato, verra
visualizzato un codice di sblocco.
Tale codice dowra essere fornito al senizio clienti per poter recuperare la password.

Passcode
Ite Unlock 330DB3
LOGIN
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3.1

Software di programmazione

Viene fornito a corredo il software Processor Programmer, compatibile con i sistemi operativi a 32 e
64 bits Windows Xp, Windows 7, Windows 8.X, Windows 10 per I'impostazione di tutte le funzioni
del processore audio.

La connessione awiene mediante:

e porta seriale 9600 baud 8N1

e porta ethernet protocollo TCP-IP (Con modulo streaming)
e porta ethernet protocollo UDP

Finestra principale

Nella finestra principale & possibile selezionare il tipo di connessione, tramite porta COM o tramite
porta ethernet utilizzando il protocollo TCP-IP (se presente modulo streaming) o protocollo UDP (se
presente modulo ethernet). Per stabilire la comunicazione, una wlta selezionata la porta, si
connetta il processore al PC e si prema il tasto “Connect”. Se la comunicazione & corretta, |l
programma leggera tutte le impostazioni del dispositivo e informazioni relative al tipo di prodotto,
versione hardware/firmware di questo e il numero seriale.

WP Processor Programmer

P
Pa yde  Processor  System |
y Abort
Connection

Comm Interface

TCP-IF

Serial port: orta di cormunic:

Gek Info

Comim Inke:
s TCP-IP
168

Port: S4000 =

Comen Inkerface

Serial TCP-1P * LDP

© 2025 ITEL Elettronica e Telecominicazioni Snc



24

DMPX Digital stereo coder

3.2

3.2.1

Audio/System

In questa sezione sono presenti i controlli e le impostazione delle fonti audio in ingresso e uscita e
parametri di sistema.

Impostazioni ingresso

In questa pagina é possibile selezionare e impostare i livelli degli ingressi, impostare il backup audio
automatico (fallback).

AUDIO Input-Output
Audio Input  Analog input
Analog In Level dB 0,0

Digital In Level dB 0,0

2 MNetwork In Level dB > Analog Output Mode Clipped and filtered
-18 Analog Out Level dB > Analog Output Deemphasis 50uS
 AES OutLevel dB
*U Input 30Hz HPF

16 Audio Badwp Enabled

Audio Source 1 Metwork Alarm Timeout (5)
AES EBU

ack Timeout (S)
Analog input neout (5]

Network - MPX Input ~ Alarm Thresheld (dE)

read Update

Nella finstra di sinistra sono \isualizzati i livelli relativi ai canali di ingresso e uscita, il canale
selezionato e lo stato del clipping relativo al canale Analogico e MPX

L'etichetta del canale attualmente in onda verra evidenziata in verde acceso e la stessa \erra
riportata sotto alle barre corrispondenti al livello di uscita (canale NET nellimmagine di esempio).

L'indicatore posto accanto alle caselle di selezione degli ingressi, come pure il bordo delle etichette
degli ingressi puo assumere diverse colorazioni a seconda dello stato dellingresso corrispondente:
ROSSO=allarme - ingresso inutilizzabile.

ARANCIO=attenzione - livello sotto soglia, conteggio awiato (¢ normale che lampeggi ogni tanto in
corrispondenza di pause di parlato).

VERDE=0K - ingresso utilizzabile.

GRIGIO=ingresso non utilizzato.

L'indicazione delle barre di uscita (output) indicano il livello assoluto all'uscita MPX e non risente
quindi delle impostazioni di livello dell'uscita.

Queste ultime quindi corrisponderanno al livello indicato dalle barre solo se i rispettivi valori sono
stati impostati a 0.0dB, altrimenti verranno scalate di conseguenza.

Per la descrizione dettagliata dei seguenti parametri, si faccia riferimento alla sezione relativa alle
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regolazioni ingresso audio, audio backup.

Read: esegue la lettura dei parametri impostati
Update: trasferisce al dispositivo le modifiche

3.2.2 Impostazioni di sistema

In questa pagina & possibile attivare il coder rds opzionale, regolarne il livello, modificare i livelli di
uscita MPX e configurare i parametri di rete relativi al modulo ethernet istallato nel dispositivo.

System

RDS Enabled
MET IP

20 192 . 168

Filot Level KHz 6,0 MET MASK,

2 2
Pilot Phase = 0,00 &5 . 9

MET GATEWAY

= e

3 Preemphasis 50us
NET PORT 54000 5
t MPX Out Level dB 0,0

0 Mpx Audio Level % 100

Qut Clip level dB

MNetwork Preemphasis Limiter

ead Update

| parametri di rete mostrati in questa finestra sono attivi quando €& presente il modulo lan standard,
se invece é stato installato il modulo streaming, la configurazione di rete andra fatta attraverso il
webserver del modulo stesso.

Per la descrizione dettagliata dei seguenti parametri, si faccia riferimento alla sezione relativa alle
regolazioni uscita Mpx, impostazioni livello clipper e preefasi, impostazioni sistema

RDS Enabled, RDS lewel, Pilot Lewel, Pilot Phase,
Modulation, Preemphasis, MPX Ouput Level, MPX Audio Level
NET IP, NET MASK, NET GATEWAY, NET PORT

Read: esegue la lettura dei parametri impostati
Update: trasferice al dispositivo le modifiche
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3.3

Salvataggio - caricamento configurazione di sistema da file

Il software permette il salvataggio e il caricamento di profili di sistema personalizzati attraverso il
menu File>System, questo include tutti i parametri inclusi nelle sezioni "System" e "Audio Input-

Output”.
Save System config to Disk

Load Systern Configuration

Save System Ceonfiguration

Salvain | Audio Processor j I‘j‘ E~
|-_._ Mome = Tipo Dimensione
b - -
Risorse recenti | System conf!g mod.dprobsys F!Ia DPROGSYS 2KB
| System config.dprobsys File DPROGSYS 2KB
Desktop
Ha‘cco?ta
LY
Computer
= %
“w
Rete
4 T | +
Mome file: |System corfig mod.dproGeys j Salva |
Salva come |DPROESYS Files j Annulla

la configurazione di sistema verra salvata su disco.

Load System config from Disk

Load System Configuration

Save System Configuration

Cerca in: | Audio Processor j £ B
= Mome = Tipo Dimensione
s
=¥ [ 5ystem config mod.dprofisys File DPROGSYS 2KB
Risorse recenti - -
|| System config.dprobsys File DPROGSYS 2KB
Deskiop
Ha‘cco?te
L "
Computer
e J
A
Rete
4 1 | [*
MNome file: |System corffig dpro6ays j Apri |
Tipo file: [DPROBSYS Fies =] Annula

la configurazione di sistema verra caricata sul dispositivo.
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3.4 RDS

Le pagine di configurazione del modulo RDS saranno visibili se l'opzione RDS é stata attivata.

3.4.1 Finestraflags

Connection DS Generator
Flags
Current Page

Station ID
Read

Program Ty, Country Coverage FI Code

= 5380 Write

Music

Artificial Head
Compressed
Enable Radiotext
Switch off RDS on audio mute All RDS paramete

Read Coder

Program Coder

Abort

In questa finestra sono presenti i parametri di configurazione dell’encoder.
RDS ENABLED: abilitazione coder RDS.

PTY: Program TYpe
Impostazione della tipologia di programmazione effettuata dall' emittente.

PI: Program Identification

Codice identificativo dell’emittente. Il codice & composto da 4 cifre, di cui la prima cifra indica il
paese di provenienza, la seconda indica I'area di copertura e le rimanenti identificano I'emittente
nell’ambito dell’area di copertura.

La prima cifra, per I'ltalia, va impostata a 5.
Per la seconda si scelga, a seconda dell’area senita, uno fra i seguenti codici:

0 Copertura locale, I'emittente ha un’unica frequenza
1 Internazionale

2 Nazionale

3 Sowra regionale

4.F Codici per emittenti regionali
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Prestare molta attenzione alla scelta del codice che identifica la copertura. Se I'emittente possiede
piu di una frequenza dovra necessariamente scegliere un codice di copertura sovraregionale (3) o
regionale (da 4 a F). L'utilizzo del codice 0 disabilita, in molti ricevitori, la gestione delle frequenze
alternative da parte di questi, in quanto identifica emittenti con un'unica frequenza di emissione. Il
suo utilizzo pertanto va limitato esclusivamente a questo caso.

Le ultime due cifre identificano I'emittente nell’area di copertura e dowanno essere differenti da tutte
le altre emittenti che insistono nello stesso bacino.

Qualche esempio:

5001: emittente italiana (5) a copertura locale (0), codice di programma 01
5202: emittente italiana (5) a copertura nazionale (2), codice di programma 02
54AF: emittente italiana (5) a copertura regionale (4), codice di programma AF

Si rammenta che e particolarmente importante che il codice PI sia unico nell’area di senizio
dell’emittente, in caso contrario si verifichera il cambio di frequenza anche verso I'emittente estranea
che possiede il codice Pl uguale alla propria.

Il codice PI, se gia conosciuto, pud essere inserito direttamente nella casella “Pl Code”, altrimenti si
puo generare scegliendo la nazione da cui viene originato il programma (Country) e la copertura di
guesto (Coverage). Sara infine a cura dell'utente la scelta delle ultime due cifre del codice.

TP: Traffic program
Indica se I'emittente, durante la normale programmazione, trasmette notiziari di traffico.

TA: Traffic Annonunce
Notiziario di traffico in onda. Tale flag dowebbe essere e rimanere attivo durante la trasmissione dei
notiziari di traffico.

MUSIC: Flag che indica se l'emittente & solita trasmettere musica o parlato. Alcuni ricevitori
utilizzano questa informazione per applicare una particolare equalizzazione all'audio o cambiarne il
wlume a seconda del tipo di programma diffuso.

ARTIFICIAL HEAD: Flag che indica che il programma in onda & stato registrato utilizzando una
testa artificiale. Questo dispositivo € appunto una testa umana artificiale con due microfoni posti
esattamente nei condotti auricolari, utilizzata in fase di registrazione di un evento live, al fine di
riprodurne in maniera molto accurata, se riascoltato mediante una cuffia, la spazialita originale.

COMPRESSED: Flag che indica se il programma in onda € stato compresso
STEREOQO: Tale flag viene commutato automaticamente in base al tipo di modulazione scelto.

ENABLE RADIOTEXT: Flag per 'abilitazione della trasmissione del radiotext.
Se disabilitato, non verra trasmesso il blocco RDS tipo 2A.

SWITCH OFF RDS on AUDIO MUTE: Abilitazione dello spegnimento della codifica RDS in
mancanza di audio in uscita. Questo evita la possibilita di sintonizzarsi in una frequenza muta, la
funzione RDS off viene segnalata con il lampeggio del led verde posto sul frontale del dispositivo.

STATION ID: Nome identificativo del dispositivo, questa stringa di lunghezza max. 16 caratteri, puo
essere assegnata al coder per la sua successiva identificazione e viene \Visualizzata unicamente nel
menu principale dell’apparato.
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3.4.2 FinestraPS

Conneckion

PS

PS Duration {secs) Current Page

MYRADIO
Read

Wiribe Modified

Clear all

all RDS parameters

Abort

o oo o o o o o o o o o o o o o oo B

In questa finestra & possibile inserire le stringhe PS che verranno \Visualizzate nel ricevitore, ognuna
delle quali pud essere lunga fino a 8 caratteri. Per ogni stringa si pud impostare la durata di
visualizzazione in secondi. Un tempo impostato pari a zero, disabilita la stringa corrispondente.

READ: Pulsante per la lettura di tutte le stringhe PS presenti nel coder. Attenzione: verranno
sovrascritte le stringhe presenti nella griglia del programma.

WRITE: Pulsante per il trasferimento delle stringhe PS nel coder. Attenzione: verranno sovrascritte
le stringhe presenti nella griglia del programma.

WRITE MODIFIED: Vengono trasferite solo le stringhe che sono state modificate
CLEAR SELECTED: Pulsante per la cancellazione delle sole stringhe selezionate nella griglia.

CLEAR ALL: Pulsante per la cancellazione di tutte le stringhe presenti nella griglia.
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3.4.3 Finestraradiotext

RDS Generakaor

RadioText

RadioText Duration {mins}) Current Page

My Radio, best skakion in bovn 1
Read

¥es, it is really the best

Wiribe Modified

Clear

Clear all

all RDS parameters

Program Coder

Abort

In questa finestra & possibile inserire le stringhe radiotext , ognuna delle quali pud essere lunga fino
a 64 caratteri. Per ogni stringa si pud impostare la durata di visualizzazione in minuti. Un tempo
impostato pari a zero, disabilita la stringa corrispondente.

READ: Pulsante per la lettura di tutte le stringhe radiotext presenti nel coder.Attenzione: verranno
sovrascritte le stringhe presenti nella griglia del programma.

WRITE: Pulsante per il trasferimento delle stringhe radiotext nel coder.Attenzione: verranno
sovrascritte le stringhe presenti nel coder.

WRITE MODIFIED: Vengono trasferite solo le stringhe radiotext che sono state modificate, in
questo caso la stringa RT2 che & marcata dall'indicatore rosso come modificata.

CLEAR SELECTED: Pulsante per la cancellazione delle sole stringhe selezionate nella griglia.
CLEAR ALL: Pulsante per la cancellazione di tutte le stringhe presenti nella griglia.
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344

Finestra AF List

Flags AFList
Freq Info ~ aflist1

AF 1 101.0 —
AF 2 104.4 Aflist2
AF 3 104.5 Af list 3
AF 4

Af list4
AF 5

Current

AF B Af list 5
AF 7

Af list6
AF &
AF 9 Af list7
AF 10 ]

Af list8
AF 11
AF 12 Af list g
AF 13 Af list 10
AF 14 P Zod

. 'rograrn Coder

= Af list 11
AF 16 Af list 12 Abort;
AF 17
lagge | @ ""/}&| Af list 13

L'encoder RDS permette linserimento di frequenze sia con metodo "A", sia con metodo "B". La
scelta fra i due metodi dipende dalla struttura della rete e dal numero di frequenze alternative
presenti. Non esiste un flag che indichi al ricevitore se le tabelle di frequenze alternative sono
trasmesse mediante metodo "A" o "B", la differenza fra i due metodi infatti & nella disposizione delle
frequenze nelle tabelle.

Nota: non e possibile compilare liste diverse utilizzando il metodo A e B contemporaneamente. Il
metodo A va utilizzato solo quando la rete possiede un massimo di 25 frequenze e non fa
programmazione differenziata a livello regionale. 1l metodo B va invece utilizzato quando le
frequenze alternative sono superiori a 25 oppure quando, allinterno della stessa rete, awiene la
diffusione di programmi regionali, ad esempio notiziari locali, solo su alcune frequenze. Le liste
vanno compilate partendo dalla prima e vanno riempite non lasciando liste vuote: le liste successive
alla prima lista vuota non verranno trasmesse.

© 2025 ITEL Elettronica e Telecominicazioni Snc



32

DMPX Digital stereo coder

3441

3.4.4.2

Editing

Af list1 Current Page

Af list2 Read

Clear lisk Af list 3
Sort Frequencies
Build B List
Insert

w'rike

Af list4

Af list 5
Rermone

Af list6

Af list7
Clear all

Af list 8
all RDS parameters

Af listg

Af list 10

AF list 11 Program Coder

Af list 12 Abark

Af list 13

Nel menu popup richiamabile mediante il tasto destro del mouse, vi sono i principali strumenti per la
compilazione della lista.

Clear list: Cancella la sola lista corrente

Sort Frequencies: Ordina tutte le frequenze inserite in maniera ascendente

Build B List:

Insert: Inserisce una nuova frequenza nel punto richiesto e sposta in basso le altre frequenze
presenti in lista.

Remove: Rimuowe la frequenza selezionata.

Metodo A

Questo metodo ¢ il pil semplice ed é indicato per tutte quelle emittenti che abbiano un massimo di
25 frequenze alternative e che non facciano programmi differenziati su base regionale.

Per implementare tale metodo, & sufficiente inserire nella lista AF list 1 tutte le frequenze
dell’emittente in ordine crescente.

Esempio:
88.5
91.3
104.1
104.5

© 2025 ITEL Elettronica e Telecominicazioni Snc



Software di programmazione 33

3.4.4.3 Metodo B

Questo metodo € indicato qualora I'emittente abbia piu di 25 frequenze alternative o qualora
un'emittente pluriregionale o nazionale, in differenti momenti della giornata, diffonda programmi
regionali differenziati. In questo metodo, il numero di liste occupate & uguale al numero di ripetitori
presenti, per cui viene diffusa la frequenza capolista di ogni ripetitore e tutte le sue possibili
alternative. Ogni frequenza alternativa viene trasmessa sempre in coppia con la frequenza capolista
a cui appartiene; l'ordine della coppia capolista-alternativa definisce se quella particolare frequenza
alternativa € una variante regionale della frequenza capolista. Ogni lista inizia con la frequenza
capolista, seguita da 12 coppie capolista-alternativa; qualora le frequenze alternative fossero
maggiori di 12 per la stessa capolista, sara possibile utilizzare due o piu liste. Se invece una stessa
frequenza capolista viene utilizzata piu di una wolta nella rete, la lista delle frequenze alternative
andra separata mediante una lista avente una diversa capolista in modo che il ricevitore non associ
erroneamente le frequenze alternative alla stessa capolista. Le coppie capolista-alternativa vengono
generalmente trasmesse in ordine crescente qualora la frequenza alternativa trasmetta in ogni
momento della giornata la stessa programmazione della frequenza capolista.

L'ordine decrescente & invece utilizzato per indicare che la frequenza alternativa € una variante
regionale della capolista, pertanto, in diversi momenti della giornata, potrebbe trasmettere una
diversa programmazione.

Per semplificare la programmazione di una lista B, si ponga, come prima frequenza, la frequenza
capolista, a seguire tutte le frequenze alternative (max. 12) e si prema il pulsante “Build B list”. Se si
desiderasse a questo punto aggiungere una nuova frequenza alternativa, la si inserisca in coda alla
lista appena compilata e si prema nuovamente il pulsante “Build B list”.

AFList
Freq Info = AF list 1 Current Page
AF 1 Q0.0
AF 2 104.5 Aflist2
AF 3 93.5 Af list 3 .
‘wirite

AF 4 105.2

Af list4
AF 5 106.7

Wirite Current

AF & 104.9 Af lists
AF 7

Af list6
AF &
AF 9 Af list7

Clear ol

AF 10

Af listd
AF 11 &ll RDS parame
AF 12 Af listg
AF 13 Af list 10
AF 14
" Af list 11
AF 16 Af list 12 Abork
AF 17
laggn | @/ Af list 13

Le frequenze sono state immesse, inserendo come prima frequenza la capolista.
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Current Page

Wirite Current

Abork

Flags AFList
Freq Lol “ | aflist 1

AF 1 Q0.0 Main Freq —
AF 2 90.0 Main Freq Aflist2
AF 3 93.5 Af list 3
AF 4 Q0.0 Main Freq

Af list4
AF 5 104.5
AF 6 20.0 Main Freq Af lists
AF T 104.9

Af list6
AF 8 Q0.0 Main Freq
AF 9 105.2 Af list7
AF 10 Q0.0 Main Freq .

Af listd
AF 11 106.7
AF 12 Af list 9
LA A list 10
AF 14
AF 15 Af list 11
AF 16 Af list 12
AF 17
Sekia w || AF list 13

Premendo il tasto “Build B List”, si ottiene la lista compilata con metodo “B”.
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3.4.5 Salvataggio - caricamento profili da file

Il software permette il salvataggio e il richiamo di profili da file precedentemente salvati attraverso il
menu File>RDS:

Load Configuration

Load Configuration

Configuration

Cercain | 23 Ust Presets v| €] 5 S
) Rds 02_2015 rds
{ Rds 10_27014 rds
Documenti Rds Stationl .rds
recenti Rds Station2.rds
=
L
Desktop
Drocumenti
Risorse del
computer
" Marme file: V| I Apri I
Risorse direte | Tipo file: |F|DS Files v | [ Annulla ]

Save Configuration

Salva con nome E]
Salvain | 129 Usr Presets v | QF -
Y Rels 02_2015.rds
i Rds 10_2014 rds
Documenti Rds Stationl .rds
recenti Rds Stationz.rds
?"_‘
L
Desktap
Drocumenti
Risorse del
computer
" Mome file: F:d::: ( = | I Salva I
Risorse direte | Salva come: |F|DS Files v| [ Annulla ]

In questo modo € possibile salvare su disco tutti i dati relativ al coder rds in un file con estensione
.rds, questo file pud essere caricato nel dispositivo con la successiva procedura "Load
Configuration".
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3.5

Impostazione Password

MultiBand Processor Prograrmm

TCP-IP = LUDP

. 188 . . 50 Disconnect A

54000 -

Get Info

Se lo si desidera & possibile proteggere I'apparato mediante un codice numerico di accesso. |l
codice di default & 0000 (disabilitato), ma € possibile cambiarlo tramite la procedura descritta in
seguito:

Change Passcode: permette di modificare la password di accesso al dispositivo.
Digitare la password corrente, 0 0000 se nessuna password € attiva, nell'editor "Passcode", la nuova
password nell'editor "NewCode" e, nuovamente, in "NewCodeConfirm" .
Selezionare quindi il menu PassCode>Change PassCode per awiare la procedura.
Warning

r] This procedure will change your current pass
% Really continue?

Store Password to disk: salva la password nel file di inizializzazione del programma in modo da
non dowerla digitare ad ogni connessione.

Change

Sko
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4

4.1

RD Link

Il software RD-Link permette la connessione del coder RDS al sistema di automazione radiofonica
per poter sfruttare le funzionalitd Radiotext Plus, TA e Clock-Time. Al momento della redazione del
presente documento, il software risulta gia compatibile con alcuni sistemi di automazione
radiofonica, ma ulteriori interfacce possono essere inserite su richiesta del cliente in modo da poter
estendere la compatibilita verso altri sistemi.

® RD-Link ¥:2.0.0.0 Raw text

File Tools

Artist-Title

Filetame: :\Documents and Settings)DeskboptRT-+Hoest, bt

Arkisk
SHAKIRA

a Tartura

03/03/15 09,40.41 RT+:5HAKIRA La Tortura

Radiotext Plus

Il radiotext plus & un senizio che, unitamente al radiotext classico, consente di contrassegnarne
parti specifiche in modo che queste possano venir isolate e utilizzate dai ricevitori predisposti. Sara
quindi possibile, ad esempio, poter disporre della playlist dell’emittente con i nomi degli artisti e i
titoli dei brani andati in onda.

Un esempio della funzionalita Radiotext (RT) con Radiotext plus (RT+)

Nel radiotext viene trasmessa la stringa seguente: "SHAKIRA - La tortura"

Un ricevitore predisposto per la decodifica del Radiotext Plus potra prendere solo alcune parti
dell'intero testo trasmesso.
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4.2 Monitor

® RD-Link ¥:2.0.0.0 Raw text

File Tools

Artist-Tile | Monitor

i:I3,I'I33,I'15 09.49.58 RT+:3HAKIRA La tortura

Nella finestra Monitor viene data una rappresentazione di quanto verra trasmesso nel PSN e nel
Radiotext, lo stato dei flags TA, CT e RT+ e dello schedulatore.

TA Arancio : flag TA attivato per notiziario di traffico in onda
Grigio: flag TA disattivato

CT Verde:viene inviato il blocco 4A corrispondente all"ora/data di sistema
Grigio: il CT é disattivato.

RT+ Blu: la stringa attualmente \Visualizzata é stata associata a Radiotext Plus.
Grigio: Radiotext Plus disattivato.

SCHED Verde:schedulatore attivo, invio Radiotext Plus abilitato
Rosso:schedulatore attivo, invio Radiotext Plus disabilitato
Grigio: schedulatore disattivato, invio Radiotext plus dipendente
dall'impostazione del flag Enable RT
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4.3

43.1

43.1.1

4.3.1.2

Configurazione

Aprire il menu di configurazione (Tools->Configuration), apparira la finestra seguente:

stai ascolkando
B [ addoffset w0 o

o

Setup

Program ID

E' possibile assegnare un nome alla finestra del file eseguibile in modo da riconoscerla rapidamente
in caso Vi fossero pit eseguibili in funzione contemporaneamente per il controllo di diversi coder (es:
pit emittenti facenti capo ad uno stesso gruppo editoriale).

Radiotext Plus e PSN dinamico

Enable RT+: abilitazione radiotext +

Le stringhe ricewte dall'automazione radiofonica verranno effettivamente passate al radiotext solo se
questo flag € attivo. Si potra inoltre aggiungere un prefisso e un separatore alle stringhe poste in
onda. Si ricorda che la lunghezza massima di una stringa radiotext in blocco 2A & di 64 caratteri. Se
la lunghezza totale della stringa, inclusi il separatore e il prefisso, fosse maggiore di questo limite,
verra automaticamente troncata.

Send RT+ titles to PSN: abilitazione invio titoli radiotext su PSN.
Abilitando tale funzione, i titoli verranno inviati anche sul PSN (gli 8 caratteri visualizzati in ogni
ricevitore dotato di RDS). Tale funzione va usata con cautela in quanto pud causare la distrazione

© 2025 ITEL Elettronica e Telecominicazioni Snc



42

DMPX Digital stereo coder

4.3.1.3

del conducente e in alcuni paesi € espressamente vietata. Si consiglia quindi di controllare le
normative in materia prima di attivarla.

Per questo motivo € stato ridotto al minimo lo scroll a singolo carattere, in quanto il programma
cerca di trasmettere principalmente interi blocchi di 8 caratteri .

Separator; separatore da inserire fra titolo e artista. Si pud scegliere un separatore differente
rispetto al radiotext.

Scroll Interval (Secs): durata dello scroll a carattere singolo.
Tutte le stringhe che non entrano in 8 caratteri, verranno visualizzate scorrendo un carattere alla
wlta utilizzando questo intervallo.

Word Interval (Secs): tempo di visualizzazione della singola parola.
Una parola che ha una lunghezza pari o inferiore a 8 caratteri, verra visualizzata intera e mantenuta
per il tempo selezionato.

Repeat Delay (S) : Il titolo verra nuovamente visualizzato sul display PSN, trascorso tale tempo (in
secondi). Inserendo un valore 0, il titolo verra visualizzato solo all'inizio del nuovo brano e quindi il
coder tornera alle stringhe PSN memorizzate internamente fino al prossimo brano in onda.

End title blank duration (Secs): se impostato diverso da 0, verra trasmesso un PSN wuoto per la
durata selezionata fra la fine della visualizzazione del titolo/artista e l'inizio della visualizzazione delle
stringhe PSN interne.

Sync start DyPSN: se abilitato, fara partire il PSN dinamico solo alla fine delle stringhe PSN
memorizzate internamente.

Restart from first PSN item after DyPs: se abilitato, fara ripartire la visualizzazione delle stringhe
PSN interne dalla prima.

TA - Clock time

Enable TA: invio comando accensione Flag TA durante notiziari di traffico.

Max duration: durata massima del comunicato di traffico. Trascorso tale tempo, se nel frattempo
non erra ricewto un apposito comando di disattivazione, il flag TA werra disattivato
automaticamente.

TA Trigger string: specifica una stringa che, associata al titolo o artista relativo al notiziario di
traffico, permette al programma di sapere quando questo viene posto in onda, attivando
conseguentemente il flag TA.

Hide traffic title string on radiotext: se abilitato, non fard \isualizzare la stringa associata al
notiziario di traffico né sul radiotext, né sul PSN.

Enable CT: invio blocco CT (clock time).

Attivando tale funzione, verra inviato automaticamente il blocco 4A per la sincronizzazione o
visualizzazione dell'orario corrente. Essendo trasmesso l'orario di sistema, si raccomanda di
mantenere sincronizzato il PC mediante un time sener.

Se il PC dovesse spegnersi o interrompersi la comunicazione fra PC e coder, la trasmissione del
blocco 4A verra sospesa.

Add offset: per aggiungere un offset all'orario correntemente trasmesso.
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4314

Interfaccia di comunicazione e impostazioni aggiuntive

Max RT+ Duration (mins): massima durata di una stringa radiotext.

Tale controllo specifica un tempo massimo di visualizzazione per le stringhe Radiotext Plus, facendo
poi tornare automaticamente il coder alle stringhe Radiotext memorizzate internamente, qualora
questo tempo dovesse venir superato. E'stato inserito per evitare, in caso di problemi sul sistema di
automazione o sul collegamento fra PC e coder, che rimanga visualizzata permanentemente I'ultima
stringa Radiotext Plus trasmessa.

Show log: visualizzazione del log delle attivita del programma.

Center PSN: giustifica al centro le stringhe visualizzate sul PSN, se di lunghezza inferiore agli 8
caratteri.

Use scheduler for dynamic contents: attiva lo schedulatore se si desidera utilizzare le funzioni di
radiotext plus e PSN dinamico solo in alcuni orari o alcuni giorni della settimana.

Create a copy of RDS file: crea una copia identica del file contenente i titoli perché questo possa
venir utilizzato da altri programmi (es: streaming encoders).

Save log: salva l'attivita del programma in un file di log tipo "log_10-03-2015.txt"

Coder interface: selezione interfaccia RS232, TCP/IP o UDP.
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4.3.2

Raw Text Importer

Il raw text importer permette di configurare limportazione di normali files di testo.

La tortura ; SHAKIRA

0y La kortura
1: SHAKIRA

1 4 SHAKIRA
0 4 % | |La tortura
i
o

Il contenuto del file attualmente selezionato (dalla finestra principale File->Raw TextFile) viene
visualizzato nella casella Raw Text Input.

| campi possono venire separati in due modi:

utilizzando i separatori: la stringhe lette dal file verranno divise utilizzando i caratteri inseriti
nell'editor "Separators".

Nell'esempio superiore, la stringa in ingresso (raw text input) "SHAKIRA;La tortura" viene divisa,
utilizzando il separatore ";".

Cio produrra due linee in uscita (linea 0: La tortura, linea 1:SHAKIRA).

Si procedera quindi, utilizzando i controlli "Artist Item" e "Title ltem" ad indicare quale linea debba

essere utilizzata come titolo e quale come nome artista.

utilizzando degli identificativi gia inseriti nel file: se nel file da interpretare il nome dell'artista e
il titolo del brano fossero gia contrassegnati da etichette del tipo

CurrArtist=Michael Jackson

CurrTitle=Thriller

si potra semplicemente inserire negli editors "Artist ID" e "Title ID" i due identificativi "CurrArtist=" e
"CurrTitle=" (privi di apici).
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4.3.3

Il programma quindi prowedera automaticamente ad isolare le stringhe relative a nome artista e
titolo.

In entrambi i casi, premendo il tasto "Test" si potranno fare delle prove con diverse impostazioni di
indici, separatori o identificativi.

Se viene selezionata la checkbox "lgnore if artist or title are null", verranno scartati gli elementi

che sono privi dell'uno o dell'altro campo
Questa funzione, unita al filtro delle parole, permette di evitare la visualizzazione di titoli di jingles,
sigle, basi musicali e tutto cid che non si voglia far apparire nel radiotext dinamico.

Word filter

Il filtro delle parole impedisce la Jisualizzazione, nel radiotext / PS dinamico, dei titoli che
contengano, in parte o interamente, una delle parole elencate.

Waord Filter

Mode

Whole Whord
Whole Word
Ay OCcurrence

Fault Ay OCourrence W || &dd

Enable word Filker

Le parole vanno digitate nella riga di inserimento, va quindi scelto il tipo di riconoscimento (Whole
Word o Any Occurrence). Premendo il tasto "Add", la parola verra aggiunta all'elenco.

Whole word: la parola, per essere riconosciuta, dowa essere interamente contenuta in una stringa.
Esempio, parola di filtro "mela": "mela" viene riconosciuta, "melanzana" non viene riconosciuta.
Any Occurrence: viene riconosciuta ogni occorrenza della stringa inserita
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4.4

Esempio, parola di filtro "moto": "moto" viene riconosciuta, ma anche "motocross", "motociclo” o

"terremoto”.

Il riconoscimento awiene sempre in modalita insensibile alle maiuscole/minuscole: inserire come

filtro "Test" o "TeSt" o "test", avra il medesimo effetto.

Schedulatore

Lo schedulatore (menu Tools->Scheduler) permette di attivare i senvizi Radiotext Plus e PSN

dinamico solo negli intervalli di tempo prestabiliti.

Scheduler, X|
@ Sun ¢ 'Mom ' Tue ' Wed . Thu ' Fri | Sak
StartTime | 0.00.00 (5 Enabled

End
23.59.59

Skart
0.00.00

Skatus
OFF

Remove

Same For all days

Clear all schedules

Si wole, ad esempio, trasmettere il Radiotext plus solo dalle 8.00 alle 12.00 e dalle 18.00 alle 23.00
di tutti i giorni, salvo la domenica dowve sara attivo per liintera giornata. Va quindi creato un ewento,
schedulato per le ore 8:00 (nell'editor "Start Time"), avente stato "Enabled" (selezionare la
checkbox). Premendo il tasto "Add", verra quindi aggiunto l'evento.
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Scheduler

00000 &

Skark End Skakus

0.00.00 8.00.00 OFF
8.00.00 23,5959 Ol

Same for all days || Clear all schedules

Ora abbiamo che dalle ore 00.00 alle ore 8.00 il coder sara disabilitato, dalle 8.00 in poi sara
abilitato. Va ora aggiunto l'evento di spegnimento alle ore 12.00, impostando 12.00 come orario
"StartTime", deselezionando la casella "Enabled" e premendo il tasto "Add".

Scheduler

120000 %

Skark End
0.00.00 5.00.00
5.00.00 12.00.00
12.00.00 23.59.59

Remove

Same for all days || Clear all schedules

Si aggiungeranno quindi gli ulteriori eventi per la riaccensione alle ore 18:00 e lo spegnimento alle
ore 23:00.
Di seguito viene indicata la programmazione ultimata.
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Scheduler

zzo000 3

Skark End

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00
23.00.00 23.59.59

Same for all days || Clear all schedules

Riassumendo, si € dapprima aggiunto l'evento per l'accensione alle ore 8.00, poi l'evento per lo
spegnimento alle ore 12.00, per l'accensione alle ore 18.00 e lo spegnimento alle ore 23.00. Dato
che questa ¢ la programmazione per lintera settimana, si pud copiarla, semplicemente premendo il
tasto "Same for all days", in tutti gli altri giorni.

Scheduler
@ [~ @

zzo000 3

Skark End

0.00.00 §.00.00

§.00.00 12,00,00

12.00,00 18.00.00

18.00.00 23.00,00 Remove
23.00.00 23.59.59

Update

Same for all days || Clear all schedules

Una wolta confermata la copia in tutti i giorni settimanali, si puo verificare che, cambiando il giorno
della settimana, tutti i giorni ora contengono la stessa programmazione. Fatto cio, si pud ora
modificare il solo giorno di Domenica in cui € richiesto che I'invio sia attivo per lintera giornata.

Selezionare quindi il giorno "Sun"
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Scheduler

zzo000 3

Skark End

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00
23.00.00 23.59.59

Same for all days || Clear all schedules

Premere il tasto "Clear" per rimuovere tutte le schedulazioni dal giorno corrente. Dopo aver
confermato la cancellazione della programmazione del giorno corrente, si aggiunga un unico evento,
con partenza alle ore 00:00, che abiliti l'invio.

Scheduler

Skart Skatus
0.00.00 23.99.59 OFF

Remove

Same for all days || Clear all schedules

La programmazione € completata, si pud premere il tasto "OK" per salvare la programmazione ed
uscire dalla finestra corrente.

Segue descrizione degli ulteriori controlli presenti:

Remove: rimuove I'elemento selezionato

Update: aggiorna l'elemento selezionato con nuove impostazioni di orario o stato abilitato/
disabilitato

Clear all schedules: elimina tutte le pianificazioni orarie in tutti i giorni.
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5 Modulo audio streaming

Il modulo audio streaming aggiunge funzionalita avanzate per la ricezione di flussi streaming,
adattandosi perfettamente alle attuali necessita di gestire flussi audio tramite protocollo TCP/IP.
L'uscita audio viene trasferita in formato digitale al processore audio / codificatore stereo, ottenendo
cosi la massima qualita audio.

5.1 Modulo decoder IpStream

Collegare l'apparato alla rete LAN, aprire un browser web su un PC da cui & possibile accedere
all'apparato e digitare nella barra degli indirizzi del browser web: http://192.168.1.100.
Il server web interno del modulo audio carichera la pagina di accesso predefinita.

itel _' stream

Username

Login predefinito username/password € admin/admin.
Nel caso in cui si modifichi la password ed essa stessa venga, smarrita, &€ possibile recuperarla
tramite il link FORGOT PASSWORD:
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Il recovery code & 90355447.

Da inserire in casella e cliccare sul tasto SUBMIT.

+" Your password is reset to default (admin )

Una wlta effettuato correttamente il login, si awa accesso a tutte le impostazioni del modulo e si
presentera la pagina di STATUS:

STREAM 1
STREAM 2

use

MAIN STREAM BACKUP STREAM

CONNECTED DISCONNECTED

Accedere quindi al menu "Streaming settings" e impostare uno o pitt URL da cui ricevere lo
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streaming audio.

E' possibile anche configurare le impostazioni relative al fallback da drive USB, il quale andra in onda
nel caso in cui nessuno stream sia disponibile.

Salvare la configurazione corrente premendo il pulsante "Save configuration”.

68.1.101/xstream USB FALLBACK SETTINGS

01/xstre @@ Enable USB Fallback

SWAP Main/Bck @@ Interleave SONGS/JINGLES

Evey 2 B sonGs Pay 1 [ JINGLES

METADATA ROUTER SETTINGS

Available USB files
@I® Redirect MetaData to RadioText

SAVE CONFIGURATION

Il modulo decoder audio streaming consente la ricezione di streaming MP3/AAC+/HLS/FLAC/WAV
da seners shoutcast mediante connettivita TCP/IP. Il modulo permette anche la riproduzione di files
audio da pendrive USB.

Per il backup audio da USB inserire una pendrive o unita di memoria Usb formattata in FAT32
contenente file audio in formato Mp3, AAC, FLAC, WAV.

| dettagli delle impostazioni sono descritti a lato delle stesse pagine di configurazione nel websener
integrato.

Una wolta configurato il modulo, agire sul processore audio, selezionare ora lingresso audio
"NetAudio": dowa essere possibile ascoltare lo streaming audio ricewito dal modulo.

Regolare, se necessario, il livello di ingresso audio dellingresso "NetAudio". Se si intende utilizzare
un qualsiasi processo audio durante la riproduzione da streaming, tale regolazione potra anche
essere omessa in quanto il processore prowedera al livellamento automatico. Il preset per l'ingresso
di rete si potra scegliere nella finestra successiva, una wlta selezionato l'ingresso NetAudio.

Se si desidera utilizzare piu di una fonte audio, per limpiego con il commutatore automatico
(fallback audio) interno, procedere alla selezione di questo ed impostare quindi il relativo preset.
Impostare infine la commutazione automatica degli ingressi selezionati.
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5.11

Status

Nella sezione Status vengono \isualizzate le informazioni relative allo stato di connessione degli
stream, ai livelli audio e la sorgente attualmente in onda.

STREAM 1
L van

STREAM 2

usB

MAIN STREAM BACKUP STREAM

hittp:/

CONNECTED DISCONNECTED

Attraverso il sinottico € possibile avere una rappresentazione in tempo reale dello stato delle varie
sorgenti e dello scambio.
| colori delle caselle relative alle sorgenti rappresentano i vari stati:

VERDE: Stream connesso

GIALLO: Stream connesso ma con audio ( di almeno un canale) sotto la soglia di silenzio
ROSSO: Stream non connesso

GRIGIO: Sorgente disabilitata( solo USB )

Vengono visualizzate anche le varie informazioni relative alla sorgente in onda, che puo essere il
Main stream, Backup stream o il fallback USB:

e BUFFER LEVEL: Livello del buffer audio, in percentuale

e METADATA: La stringa dei metadati estratta dallo stream( o le TAG ID3 / Nome file nel caso del
fallback USB )

e LEFT/RIGHT LEVEL: Liwello audio, in dB. La barra "solida" rappresenta il valore RMS dell'audio, la
barretta rossa invece il valore di picco.
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5.1.2

Streaming settings

La sezione seguente permette di impostare uno o pitu URL da cui ricevere lo streaming audio.
E' possibile anche configurare le impostazioni relative al fallback da drive USB, il quale andra in onda
nel caso in cui nessuno stream sia disponibile.

168.1.101/xstream USB FALLBACK SETTINGS

@@ Enable USB Fallback

.168.1.101/xstream

SWAP Main/Bck @@ Interleave SONGS/JINGLES

Evey 2 [l songs pPay 1 [ JNGLES

METADATA ROUTER SETTINGS

Available USB files
@@ Redirect MetaData to RadioText

SAVE CONFIGURATION

Main Stream: Indirizzo Url streaming principale
Backup Stream: Indirizzo Url Streaming secondario o di scorta

Redirect Metadata to RadioText: Trasmette in RadioText il contenuto dei metadati contenuti nello
streaming verso il coder RDS (se opzione presente e se abilitato), per la gestione del coder RDS
vedere il paragrafo dedicato.

Consente inoltre di interpretare la formattazione dei metadati, in modo tale da popolare
correttamenrte le tag RT+.

E' possibile impostare la stringa separatrice dei vari campi ( nellimmagine é la tilde ~ ), ed il
significato degli stessi.

Ad esempio, con riferimento all'immagine, un metadato del tipo
"MIKA~Grace Kelly"

Comporterebbe I'estrazione dell'artista "MIKA" e del brano "Grace Kelly", andando quindi a popolare
correttamente il RT e RT+ con le relative tag.

Se non iene specificato un separatore, od esso fosse non corretto, la stringa metadati verra
interamente inoltrata al RadioText senza modifiche ed elaborazioni ulteriori.

Enable USB Fallback: Attiva la funzione di backup audio da USB nel caso nessun stream sia
giudicato valido per la messa in onda.

Interleave SONGS/JINGLES: Consente di intervallare, ogni X canzoni, Y jingles.
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5.13

Per il corretto funzionamento del backup USB, inserire un supporto dati formattato in FAT32 o
NTFS.
E' mandatorio che esso abbia la seguente struttura di cartelle:

0 ROOT
" songs
= jingles
Se non presenti, verranno automaticamente create dall'apparato. Popolare quindi di canzoni la
cartella "songs" e di jingles la cartella "jingles".
Il tutto e in ogni caso accessibile anche via FTP da remoto, usando gli stessi login ( username/

password ) utilizzati per effettuare login via web.
La porta di default & la 54021, modificabile nel menu NETWORK SETTINGS.

Save Configuration: Salva le modifiche della pagina.

Network settings

Nella pagina seguente si configurano i parametri relativi ad IP, SMTP, NTP.

IP CONFIG

54000

54021

IP CONFIG:

IP Address: Indirizzo Ip assegnato al modulo, default 192.168.1.100

Subnet Mask: Subnet mask , default 255.255.255.0

Gateway: Indirizzo Ip del gateway, default 192.168.1.254

DNS Primary: DNS resolver principale, default 8.8.8.8

DNS Secondary: Indirizzo Ip assegnato al modulo, default 8.8.4.4

TCP serial tunnel port: Porta utilizzata per la connessione all'apparato tramite I'applicativo
Processor Programmer, per PC Windows

USB FTP Port: Porta utilizzata per accedere in FTP al contenuto del drive USB usato come
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fallback. Utilizzare lo stesso login utilizzato per il web.

SMTP CONFIGURATION

NO

email@itel.it sssssssssss

NO

SMTP CONFIG:

Usato per la configurazione dellinvio delle email di allarme. Consente di impostare un account per
I'invio e fino a 3 riceventi.

SMTP server: Mail sener di uscita

SMTP port: Porta utilizzata dal server

Authentication: Abilita o disabilita l'autenticazione nel mail server
Username/Password: Significativi solo se l'autenticazione € abilitata,
Require SSL: Abilita o disabilita la cifratura SSL

Sender email address: Indirizzo mail dell'account utilizzato per l'invio

Recipient (N) Email: Destinatario delle mail di allarme

0.europe.pool.ntp.org

ntpl.infim.it

ntp2.inrim.it

NTP CONFIG:

Consente di impostare 3 server NTP.
Default:

¢ time.nist.gov
e ntpl.inrim.it
e ntp2.inrim.it
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5.14

System settings

E' possibile cambiare lo StationID, la password per il login da WEB e da FTP ed altri parametri
relativi al changeowver audio.

Test10050Dpro6

Europe/Rome

SAVE CONFIGURATION

Station ID: identificativo apparato. E' un'etichetta caratteri a disposizione dell'utente per identificare
I'apparato. Viene visualizzato anche sul pannello frontale della macchina, non pud essere usato per
I'RDS.

System password: Password usata per login da web e da ftp

Volume: Range +-5 dB, consente di amplificare o attenuare l'audio proveniente dallo stream/USB
prima di essere immesso nel NetAudio dell'apparato.

Buffer: in secondi, range 5-50, consente di impostare la durata del buffer audio per gli streaming. Un
buffer audio pit grande € piu resistente nei confronti di cattive condizioni di rete, ma introduce un
ritardo maggiore.

Timezone: Da impostare in modo da avere un corretto fuso orario nella macchina e quindi avere i
log degli allarmi e degli eventi correttamente collocati temporalmente.

Changeover switch time: Timeout usato in fase di "silenzio" di una sorgente: trascorso almeno
tale tempo con sorgente dichiarata muta, il changeover scambiera nella sorgente a priorita
immediatamente piu bassa.

Changeover switchback time: Timeout usato in fase di recupero di una sorgente: trascorso
almeno tale tempo con sorgente dichiarata suonante, il changeover scambiera nella sorgente a
priorita immediatamente piu alta.

Silence threshold: Soglia livello audio RMS, in dB. Se entrambi i canali sono al di sopra di tale
valore, la sorgente verra dichiarata suonante. Se almeno un canale € al di sotto di tale valore, la
sorgente verra dichiarata muta.
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5.1.5 Alarm settings

Pagina per impostare la modalita di reportistica riguardante gli allarmi.
E' possibile scegliere se abilitare 0 meno il controllo di un particolare allarme, se inviare 0 meno
TRAP/EMAIL e un timeout in modo tale da noticare solo gli allarmi che durano piu a lungo di esso.

ALARM SETTINGS

Enable
ALARM

Main stream disconnect

Backup stream disconnect

Main source not available

SAVE CONFIGURATION

Enable Alarm: Abilita/disabilita il controllo di tale allarme

SNMP TRAP: Abilita/disabilita l'invio delle TRAP e delle EMAIL in caso di allarme/deallarme
DELAY TRAP: Timeout in secondi. Solo gli allarmi che durano piu di esso vengono notificati. Anche
I'evento di risoluzione dell'allarme viene notificato solo se dura per almeno il periodo di timeout.

LISTA ALLARMI:

Main stream disconnect: Viene notificato quando lo stream principale non & disponibile

( disconnesso o audio sotto soglia )

Main stream disconnect: Viene notificato quando lo stream secondario non € disponibile

( disconnesso o audio sotto soglia )

Main source not available: Viene notificato quando la macchina, originariamente sul suo ingresso
principale ( Analog input o Digital input ) scambia sul NetAudio. Utile per capire che I'apparato &
passato allo streaming dalla dorsale.

5.1.6 Active alarms

Vengono visualizzati gli allarmi attualmente attivi nella macchina e data/ora di inizio

ACTIVE ALARMS

Copy  Print

Copy: Consente di copiare il contenuto della tabella
Print: Attiva una modalita appositamente formattata per la stampa.
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5.1.7

5.18

Alarm logs

Pagina dowve \iene elencato lo storico degli allarmi ( HISTORY ALARMS ) e il log eventi di sistema
(SYS LOGS).
Per ogni allarme \iene registrato il tipo, data/ora di inizio allarme e data/ora di fine allarme.

HISTORY ALARMS SYS LOGS

Reset Alarms
Streamer switch to MAIN Stream
Copy  Print CSV

New Streaming setting saved

System Started
T Type Start 1 End

MAIN STREAM DI CTION 7 25 11:20:45

BACKUP STREAM DI

Copy: Consente di copiare il contenuto della tabella

Print: Attiva una modalita appositamente formattata per la stampa

CSV: Attiva il download di un file CSV ( AlarmLogCSV.csv) con contenuti tutti gli allarmi della
tabella dello storico.

Reset Alarms: Elimina tutti gli allarmi memorizzati e pulisce il log di sistema.

SNMP settings

Sono presenti le varie voci di configurazione dell'agent SNMP.
E' possibile configurare fino a 3 destinatari TRAP.

TRAP CONFIGURATION

public

publicee

0

16200 unity | publiccceee

SNMP CONFIGURATION

public

private

161

SAVE CONFIGURATION
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Trap (N) Address: IP del destinatario della TRAP
Trap (N) Port: Porta utilizzata per I'invio della TRAP

Trap (N) Community: Community utilizzata dal destinatario per validare la TRAP

Public community: Password per gli oggetti Read-Only
Private community: Password per gli oggetti Read-Write

Port: Porta UDP utilizzata dallagent SNMP.

5.1.9 Splitcontrol

Consente di impostare e controllare manualmente le funzionalita di splittaggio del dispositivo

SPLIT CONTROL
Networklnput
Split not active

3600

Disable Split

Split to Analog Input
Split to Digital Input
Split to Net - Auto

Split to Net - Main Stream

Split to Net - Backup Stream

Split to Net - USB

DSP Actual Input: Indica lingresso selezionato della macchina( Analog - Digital - NET )

Split Status: Indica se la macchina & in splittaggio o meno

Split Timeout: Timeout per far tornare la macchina allo stato di riposo se il comando di split non
viene ripetuto entro esso stesso.

Disable Split: Fa tornare la macchina al default input e abilita il changeover su IpStream

Split to Analog Input: Fa splittare la macchina su Analog Input

Split to Digital Input: Fa splittare la macchina su Digital Input.

Split to Net - Auto: Fa splittare la macchina su Network Input e abilita il changeover su IpStream
Split to Net - Main: Fa splittare la macchina su Network Input e forza il changeowver di IpStream su
Main

Split to Net - Backup: Fa splittare la macchina su Network Input e forza il changeowver di IpStream
su Backup

Split to Net - USB: Fa splittare la macchina su Network Input e forza il changeowver di IpStream su
USB.
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E' possibile controllare lo splittaggio inviando stringhe, in modalita plain text, tramite la stessa porta
di controllo TCP utilizzata dall'applicazione.

Di seguito la lista dei comandi:
e Return To nain ( Disable Split ) -> [AB010002]

® Split to Anal og I nput -> [ AB010103]
®* Split to Digital I|nput -> [ AB010200]
®* Split to Net AUTO I nput -> [ AB010301]
®* Split to Net MAIN I nput -> [ ABFF0100]
® Split to Net BACKUP I nput -> [ ABFF0200]
® Split to NET USB I nput -> [ ABFF0300]

5.1.10 FWupgrade

Usata per leggere le SW release delle varie componenti della macchina, il Backup/Restore della
configurazione e il FW update.

FW UPGRADE

MX6UL_0

9C:53:CD:03:AE:9D

Sys:3.2.2.1-Proc:1.0.2.0 | 3757333730390808001300-2

Firmware file
e file Browse Start FW Update

L9

Configuration file
(Data.dat)

Choaose file Browse Restore configuration

%

Firmware File: Selezionare il file IPK per l'update del modulo. Awiare la procedura con Start FW
Update. Puod richiedere fino a 5 minuti, attendere fino al completamento.

Configuration File: Consente di salvare la configurazione attuale (Backup) o di ripristinarla
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(Restore)
MIB Download: Download diretto al file .MIB per la gestione remota dello streamer

Reboot: Riawio del modulo IpStream (non l'intera macchina).

5.2 Installazione rapida Ipstream

L'indirizzo IP di default & 192.168.1.100. Connettersi al modulo mediante un browser internet
digitando nella barra degli indirizzi: http://192.168.1.100.

Andare nella sezione "STREAMING SETTINGS" ed Impostare uno o piu URL per gli stream da cui
ricevere il flusso audio. Salvare mediante il tasto "SAVE CONFIGURATION".

Configurare le impostazioni di rete del modulo tramite la pagina NETWORK SETTINGS. Salvare
mediante il tasto "SAVE CONFIGURATION".
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